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Microsoft	Windows	specific	usage	questions	Forum	rules	Please	post	only	Windows	specific	questions	in	this	forum	category.	If	you	don't	know	where	to	post,	please	read	the	different	forums'	rules.	Thanks.	cjm1997	New	Cone	Posts:	3	Joined:	18	Sep	2021	06:13	Postby	cjm1997	18	Sep	2021	06:20	Hello	everyone,	Hoping	the	brain	trust	can	help	me
out	on	this	one.	Tried	opening	VLC	tonight,	and	it	has	all	of	a	sudden	decided	to	crash	immediately	upon	opening.	I	get	the	error	message	"Ooops,	VLC	media	player	just	crashed.	Would	you	like	to	send	a	bug	report	to	the	developers	team?"	When	I	hit	yes,	the	error	message	goes	away,	but	nothing	else	happens.	Already	tried	uninstalling,	rebooting,
and	reinstalling	with	no	luck.	I'm	at	a	loss.	No	video	or	MKV	files	are	being	played,	only	audio	(WAV,	FLAC,	MP3,	etc.)	Anyone	have	any	ideas?Thanks	Last	edited	by	cjm1997	on	18	Sep	2021	15:06,	edited	1	time	in	total.	cjm1997	New	Cone	Posts:	3	Joined:	18	Sep	2021	06:13	Postby	cjm1997	18	Sep	2021	06:22	P.S.	I'm	running	Windows	10
Professional,	64	bit	Win4US	New	Cone	Posts:	1	Joined:	04	Nov	2023	21:12	Postby	Win4US	04	Nov	2023	21:36	It's	not	resolved	for	VLC	current	release	or	prior	two	releases!	The	fix	didn't	work	for	me.	I	uninstalled	VLC,	deleted	any	remaining	files	on	C	drive,	ran	registery	repair	to	eliminate	any	VLC	associated	entries,	deleted	cache	and	preferences
and	each	time	(current	and	last	two	updates)	I	did	that	I	got	upon	completion	of	new	install	and	try	to	open	media	file	that	Ooops	message	as	others	have	stated.	I	didn't	have	this	problem	until	after	I	installed	the	latest	Window	update	today	for	my	Windows	10	Pro	(64)	system.	This	is	ridiculous	to	have	this	problem	on	a	clean	install.	It	doesn't	appear
to	submit	the	install	error	log	when	you	say	yes	either	with	Outlook	running	or	not.	Please	fix	this	so	I	can	use	it	again.	PS:	I	have	three	windows	systems	and	all	three	have	the	problem	after	Microsoft's	Cumulative	(KB5031445)	update	today.	wbtcpip	Blank	Cone	Posts:	15	Joined:	13	May	2021	16:21	Postby	wbtcpip	04	Nov	2023	22:53	it's	this	plugin
audio_output\libmmdevice_plugin.dll	that	crash	on	vlc	startup.	I	deleted	that	file	and	now	vlc	start	normally	dpatter3	New	Cone	Posts:	1	Joined:	07	Nov	2023	20:32	Postby	dpatter3	07	Nov	2023	20:34	Was	having	the	same	problem,	just	installed	3.0.20	and	everything	is	working	as	normal	Return	to	VLC	media	player	for	Windows	Troubleshooting
Jump	to	Users	browsing	this	forum:	No	registered	users	and	99	guests	Microsoft	Windows	specific	usage	questions	Forum	rules	Please	post	only	Windows	specific	questions	in	this	forum	category.	If	you	don't	know	where	to	post,	please	read	the	different	forums'	rules.	Thanks.	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby
unfinished	22	Dec	2023	05:54	Windows	10,	64	bit.	VLC	media	player	version	3.0.20	Vetinari.VLC	media	player	will	not	play	any	CD	which	includes	"store	bought"	and	"home	made"	When	I	click	on	the	play	button,	the	computer	immediately	returns	to	the	desk	top	every	time.	This	does	not	harm	the	computer	software.VLC	media	player	is	my	default
media	player	through	quite	a	few	versions.	It	has	never	been	uninstalled	and	re-installed	and	the	settings	have	never	been	changed.This	is	the	first	time	that	I	tried	to	use	VLC	to	play	a	CD	so	I	have	no	history	of	playing	CDs	on	VLC	media	player	using	older	versions	of	VLC	media	player.The	computer	will	play	all	CDs	on	Windows	Media	Player	without
any	problems.VLC	media	player	will	play	DVDs	both	"store	bought"	and	"home	made"without	any	problems.There	was	only	one	VLC	crash	report	request	(pop	up).	There	were	no	crash	report	requests	after	that	for	each	time	VLC	media	player	refused	to	play	a	CD.Any	help	so	that	I	can	play	CDs	on	VLC	media	player	would	be	appreciated.	Lotesdelere
Cone	Master	Posts:	10363	Joined:	08	Sep	2006	04:39	Location:	Europe	Postby	Lotesdelere	22	Dec	2023	13:03	Menu	Media	->	Open	DiscThen	make	sure	to	tick	the	correct	disc	option	(Audio	CD)	in	the	Disc	Selection	and	the	correct	drive	letter	in	Disc	Device.	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby	unfinished	23	Dec	2023
06:50	Thank	you	for	your	response.I	followed	your	instructions	and	when	I	clicked	the	play	button	the	computer	immediately	returned	to	the	desktop	and	did	not	play	the	CD.There	was	no	VLC	crash	report	(pop	up).	Lotesdelere	Cone	Master	Posts:	10363	Joined:	08	Sep	2006	04:39	Location:	Europe	Postby	Lotesdelere	23	Dec	2023	15:49	Please	run
VLC	from	the	command	prompt	with	this	command	line	for	creating	a	log	file:	Code:	Select	allC:\path\to\vlc\vlc.exe	--extraintf=logger	--verbose=2	--logfile=C:\temp\vlc.log	--logmode=text	--file-logging	and	then	paste	the	full	resulting	log	here	or	on	Pastebin.com	or	on	Justpaste.it	if	it's	too	long.The	destination	folder	must	already	exist	and	make	sure
that	you	have	full	access	rights	to	it.	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby	unfinished	23	Dec	2023	23:33	Thank	you	for	your	reply.	I	tried	copying	the	command	line	using	the	c:/	prompt	and	the	computer	could	not	find	the	file.	It	would	be	appreciated	if	you	could	give	me	some	instructions	on	to	run	VLC	from	the	command
prompt	with	the	enclosed	command	line	which	would	include	on	how	to	access	the	"command	prompt'	so	I	can	create	a	log	file.	Information	on	the	"command	prompt"	would	also	be	appreciated.Clarification	on	what	is	meant	by	destination	folder	and	where	to	find	the	destination	folder	would	also	be	appreciated.	Lotesdelere	Cone	Master	Posts:
10363	Joined:	08	Sep	2006	04:39	Location:	Europe	Postby	Lotesdelere	26	Dec	2023	13:55	You	need	to	use	and	type	the	complete	path	to	VLC.exe,	usually	C:\Program	Files\VideoLAN\VLC\	or	C:\Program	Files	(x86)\VideoLAN\VLC\	if	you're	using	the	32-bit	version.For	the	destination	folder	use	one	which	already	exists	(or	create	a	new	one)	and	where
you	are	absolutely	sure	to	have	full	write	access	rights.	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby	unfinished	27	Dec	2023	04:46	if	I	open	VLC	media	player	from	the	desktop,	the	CD	will	not	play	and	the	computer	ends	up	at	the	desktop	every	time.If	I	open	VLC	media	player	from	"C:\Program	Files\VideoLAN\VLC\",	the	end
results	are	unreliable.	That	is,	sometimes	the	CD	will	play,	other	times	VLC	media	player	will	not	open	and	other	times	VLC	media	player	will	open	and	crashes.I	need	instructions	on	how	to	find	the	log	in	VLC	media	player	and	once	i	find	out	on	how	to	access	the	log,	I	would	appreciate	instructions	on	how	to	use	the	log	and	how	it	relates	to	a
destination	folder.I	have	a	64	bit	computer.	Lotesdelere	Cone	Master	Posts:	10363	Joined:	08	Sep	2006	04:39	Location:	Europe	Postby	Lotesdelere	27	Dec	2023	13:38	We	need	a	log	file.Run	VLC	from	the	command	prompt	with	this	command	line	for	creating	a	log	file:Code:	Select	all"C:\Program	Files\VideoLAN\VLC\vlc.exe"	--extraintf=logger	--
verbose=2	--logfile=C:\temp\vlc.log	--logmode=text	--file-logging	And	as	said	before,	the	destination	folder	(C:\temp)	must	already	exist	and	make	sure	that	you	have	full	access	rights	to	it.	mmortal03	Blank	Cone	Posts:	30	Joined:	31	Oct	2006	07:17	Postby	mmortal03	04	Jan	2024	07:13	I'm	also	having	this	problem	when	selecting	the	audio	CD	Tracks
under	Discs.	It	no	longer	works,	possibly	because	the	"file"	URI	looks	to	be	broken	for	CDs?	Not	sure	if	the	"file"	URI	used	to	work,	but,	for	example,	the	following	also	doesn't	work	currently:"C:\Program	Files\VideoLAN\VLC\vlc.exe"	--started-from-file	file:///D:(having	a	final,	trailing	slash	doesn't	change	things,	/	or	\)	This	also	doesn't
work:"C:\Program	Files\VideoLAN\VLC\vlc.exe"	--started-from-file	file:///D:/Track01.cda	However,	using	the	"cdda"	URI	works.	For	example,	this	works:"C:\Program	Files\VideoLAN\VLC\vlc.exe"	--started-from-file	cdda:///D:	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby	unfinished	07	Jan	2024	04:08	I	followed	your	instructions	to
reset	preferences	the	manual	way	and	I	could	not	get	to	step	2	to	get	a	command	prompt	to	type	the	exe.	file.	On	clicking	on	"open"	the	computer	screen	flashed	and	reverted	back	to	Outlook.Even	worse,	I	now	have	a	black	VLC	home	screen	rather	than	the	usual	white	one.	I	understand	that	a	black	VLC	home	screen	is	not	a	good	thing.	My	VLC
media	player	will	still	not	play	a	CD	and	reverts	back	to	the	computer	desktop	when	I	click	"play".Any	additional	advice	that	you	can	give	me	would	really	be	appreciated	to	get	VLC	media	player	play	any	CD.	Also	how	do	i	get	rid	of	the	black	screen?	mmortal03	Blank	Cone	Posts:	30	Joined:	31	Oct	2006	07:17	Postby	mmortal03	07	Jan	2024	12:57	how
do	i	get	rid	of	the	black	screen?	Try	going	to	View	and	click	on	Playlist.	Another	option	is	to	just	use	the	keyboard	shortcut,	Ctrl+L.	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby	unfinished	08	Jan	2024	06:21	Thank	you,	I	was	able	to	revert	back	to	the	white	screen.Since	my	last	post,	I	tried	again	to	reset	the	preferences	using	the
command	prompt	method.	What	ever	I	accomplished,	had	no	effect	on	playing	a	CD	using	VLC	media	playerOn	occasion,	VLC	media	player	will	now	crash	with	a	crash	notice	at	the	start.	I	answered	no	to	the	crash	report	request	and	when	I	try	again,	VLC	media	player	will	start	without	crashing.Resetting	preferences	using	Tools	>	preferences	does
not	work	to	make	VLC	play	CDs.I	would	appreciate	it	if	you	can	send	me	a	line	by	line	procedure	on	using	the	command	prompt	method	of	setting	preferences	to	default	settings.	I	will	then	know	if	I	have	done	this	process	correctly	in	the	past.	This	is	not	easy	for	someone	who	has	not	done	this	process	before	and	VLC	media	player	does	not	indicate	if
someone	is	successful	after	Enter	is	pressed.	mmortal03	Blank	Cone	Posts:	30	Joined:	31	Oct	2006	07:17	Postby	mmortal03	08	Jan	2024	16:44	Thank	you,	I	was	able	to	revert	back	to	the	white	screen.Since	my	last	post,	I	tried	again	to	reset	the	preferences	using	the	command	prompt	method.	What	ever	I	accomplished,	had	no	effect	on	playing	a	CD
using	VLC	media	playerOn	occasion,	VLC	media	player	will	now	crash	with	a	crash	notice	at	the	start.	I	answered	no	to	the	crash	report	request	and	when	I	try	again,	VLC	media	player	will	start	without	crashing.Resetting	preferences	using	Tools	>	preferences	does	not	work	to	make	VLC	play	CDs.I	would	appreciate	it	if	you	can	send	me	a	line	by
line	procedure	on	using	the	command	prompt	method	of	setting	preferences	to	default	settings.	I	will	then	know	if	I	have	done	this	process	correctly	in	the	past.	This	is	not	easy	for	someone	who	has	not	done	this	process	before	and	VLC	media	player	does	not	indicate	if	someone	is	successful	after	Enter	is	pressed.	I	think	resetting	the	preferences
through	the	command	line	isn't	going	to	be	a	solution	to	this	problem.	I	think	the	problem	is	probably	a	bug	in	VLC.You	can	just	as	well	go	to	Tools->Preferences	and	click	on	the	Reset	Preferences	button,	and	maybe	restart	VLC.	If	that	doesn't	fix	it,	it's	quite	likely	a	bug	in	VLC	that	they	need	to	fix.	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020
20:55	Postby	unfinished	10	Jan	2024	05:42	I	have	tried	the	Tools	>	Preferences	method	a	number	of	times	with	no	success.So	there	must	be	a	bug	of	some	type	in	VLC."it's	quite	likely	a	bug	in	VLC	that	they	need	to	fix"	My	question	is	who	are	"they"	and	how	are	"they"	going	to	fix	the	"bug"?	mmortal03	Blank	Cone	Posts:	30	Joined:	31	Oct	2006	07:17
Postby	mmortal03	11	Jan	2024	16:07	I	have	tried	the	Tools	>	Preferences	method	a	number	of	times	with	no	success.So	there	must	be	a	bug	of	some	type	in	VLC."it's	quite	likely	a	bug	in	VLC	that	they	need	to	fix"	My	question	is	who	are	"they"	and	how	are	"they"	going	to	fix	the	"bug"?	I'm	pretty	sure	it's	essentially	this	bug:	...	ote_238413It	was
reported	five	years	ago,	lol,	and	jbk	commented	on	it	then,	and	he	added	scope	10	months	ago,	so	at	least	he's	aware	of	it...	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby	unfinished	11	Jan	2024	23:38	The	question	still	remains	how	do	I	fix	this	bug,	if	it	can	be	fixed?Would	uninstalling	VLC	and	downloading	the	latest	version	of	VLC
resolve	the	bug	problem	or	would	this	cause	more	problems	than	it	would	resolve?	If	this	option	is	suggested,	I	would	appreciate	a	link	to	download	the	latest	version	of	VLC.	mmortal03	Blank	Cone	Posts:	30	Joined:	31	Oct	2006	07:17	Postby	mmortal03	12	Jan	2024	19:30	The	question	still	remains	how	do	I	fix	this	bug,	if	it	can	be	fixed?Would
uninstalling	VLC	and	downloading	the	latest	version	of	VLC	resolve	the	bug	problem	or	would	this	cause	more	problems	than	it	would	resolve?	If	this	option	is	suggested,	I	would	appreciate	a	link	to	download	the	latest	version	of	VLC.	No,	it's	not	a	bug	with	your	configuration.	It	needs	to	be	fixed	in	the	VLC	code	for	the	Devices	menu.	As	a
workaround,	try	clicking	on	Media->Open	Disc...,	then	select	the	"Audio	CD"	option	button,	and	then	click	Play	at	the	bottom.	That	still	works	for	me.	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby	unfinished	14	Jan	2024	22:09	Thank	you	for	your	suggestion.	This	does	not	work	for	me	as	VLC	crashes	to	the	desk	top	right	after	I
click	Play.Am	I	right	to	assume	that	I	will	have	to	live	with	the	version	of	VLC	that	I	have	with	its	limitations	on	playing	a	CD	until	someone	fixes	the	VLC	code?	mmortal03	Blank	Cone	Posts:	30	Joined:	31	Oct	2006	07:17	Postby	mmortal03	16	Jan	2024	02:01	Thank	you	for	your	suggestion.	This	does	not	work	for	me	as	VLC	crashes	to	the	desk	top	right
after	I	click	Play.	That	sounds	like	more	than	one	problem	going	on.	Not	sure	if	your	crashing	is	caused	by	the	same	bug	or	not.	Presumably,	you've	tried	playing	the	CD	with	Windows	Media	Player,	just	to	make	sure	that	there's	nothing	more	generally	wrong	with	your	disc	drive?	Am	I	right	to	assume	that	I	will	have	to	live	with	the	version	of	VLC	that
I	have	with	its	limitations	on	playing	a	CD	until	someone	fixes	the	VLC	code?	Yep,	it's	not	fixed	on	the	nightly	builds,	either,	so	you've	just	got	to	wait.	unfinished	Blank	Cone	Posts:	12	Joined:	26	Jan	2020	20:55	Postby	unfinished	16	Jan	2024	19:11	My	computer	plays	CDs	without	any	problems	with	Windows	Media	Player.I	will	just	have	to	wait	until
the	VLC	coding	is	improved	to	play	CDs.	Gnafu	New	Cone	Posts:	1	Joined:	10	Apr	2024	23:18	Postby	Gnafu	10	Apr	2024	23:54	Hi,	I	have	the	same	problem:	Trying	to	read	an	Audio	CD	results	in	a	crash.The	log	file	also	gets	truncated,	notice	the	"Tryin"	it	is	not	a	copy-paste	mistake,	it	was	the	logfile	being	written	during	the	crash.	Return	to	VLC
media	player	for	Windows	Troubleshooting	Jump	to	Users	browsing	this	forum:	No	registered	users	and	99	guests	Microsoft	Windows	specific	usage	questions	Forum	rules	Please	post	only	Windows	specific	questions	in	this	forum	category.	If	you	don't	know	where	to	post,	please	read	the	different	forums'	rules.	Thanks.	tbreit	New	Cone	Posts:	1
Joined:	28	Apr	2020	22:44	Postby	tbreit	28	Apr	2020	22:55	Trying	to	get	VLC	to	install	via	SCCM,	but	the	install	stops,	waiting	for	a	the	language	selection.	I've	tried	using	"vlc-3.0.10-win64.exe	/L=1033	/Q"	and	"vlc-3.0.10-win64.exe	/Language=enGB	/Q"	(enGB	is	one	of	the	locale	folders	that	get	installed)	without	success.	I	tried	running	vlc-3.0.10-
win64.exe	/?	and	vlc-3.0.10-win64.exe	/h	from	the	command	line,	hoping	I'd	get	a	list	of	install	options,	but	no	luck,	it	just	starts	the	install	and	prompts	for	an	Installer	Language.	Is	there	anyplace	to	find	command	line	switch	options,	so	we	can	push	this	out?Thanks	in	advance.	Hitchhiker	Big	Cone-huna	Posts:	2203	Joined:	29	Jun	2018	11:40	VLC
version:	3.0.17.4	Operating	System:	Windows	8.1	Location:	The	Netherlands	Postby	Hitchhiker	29	Apr	2020	17:18	Advanced_Use_of_VLC/	Neezy	New	Cone	Posts:	1	Joined:	16	Mar	2023	21:53	Postby	Neezy	16	Mar	2023	22:10	I	successfully	was	able	to	deploy	and	have	VLC	3.0.18	install	and	run	successfully	on	windows	10	through	SCCM	but	didn't
remove	version	3.0.16I	used	the	MSI	file	to	install	3.0.18	but	I'm	unsure	how	3.0.16	was	installed.Also	version	3.0.18	Program	files	(x86)	folder	and	version	3.0.16	is	in	the	Program	Files	folder.is	there	a	way	correct	this	through	SCCM	or	do	I	need	to	manually	uninstall	3.0.16?Cheers	Return	to	VLC	media	player	for	Windows	Troubleshooting	Jump	to
Users	browsing	this	forum:	No	registered	users	and	99	guests	Microsoft	Windows	specific	usage	questions	Forum	rules	Please	post	only	Windows	specific	questions	in	this	forum	category.	If	you	don't	know	where	to	post,	please	read	the	different	forums'	rules.	Thanks.	banana	appeal	New	Cone	Posts:	2	Joined:	15	Nov	2012	04:05	Postby	banana
appeal	15	Nov	2012	04:23	Hello,	Is	there	a	setting,	extension	or	widget	that	can	get	VLC	2.0.4.	into	a	"mini	player"	mode	so	I	can	surf	while	I	watch	media	out	of	a	small	window	on	my	screen?	I'm	currently	on	Windows	7	Ultimate	with	all	updates.	Any	advice	would	be	appreciated.	TIA	Friday	New	Cone	Posts:	1	Joined:	12	Aug	2021	19:43	Postby
Friday	12	Aug	2021	19:47	is	there	any	way	to	keep	the	vlc	player	on	top?	Lotesdelere	Cone	Master	Posts:	10363	Joined:	08	Sep	2006	04:39	Location:	Europe	Postby	Lotesdelere	13	Aug	2021	12:22	is	there	any	way	to	keep	the	vlc	player	on	top?Menu	View	->	Always	on	top	Return	to	VLC	media	player	for	Windows	Troubleshooting	Jump	to	Users
browsing	this	forum:	No	registered	users	and	99	guests	Microsoft	Windows	specific	usage	questions	Forum	rules	Please	post	only	Windows	specific	questions	in	this	forum	category.	If	you	don't	know	where	to	post,	please	read	the	different	forums'	rules.	Thanks.	glvlc	Blank	Cone	Posts:	12	Joined:	08	May	2017	16:46	Postby	glvlc	23	Oct	2024	19:55
From	this	page	you	can	download	the	32-bit	portable	version	of	VLC	media	player	for	Windows.Where	can	I	download	the	64-bit	portable	version	of	VLC	media	player	for	Windows	?	glvlc	Blank	Cone	Posts:	12	Joined:	08	May	2017	16:46	Postby	glvlc	24	Oct	2024	12:24	Perfect	!	Thanks	for	providing	the	links	and	for	the	clarification	regarding	the
portable	version.	Return	to	VLC	media	player	for	Windows	Troubleshooting	Jump	to	Users	browsing	this	forum:	No	registered	users	and	99	guests	Microsoft	Windows	specific	usage	questions	Forum	rules	Please	post	only	Windows	specific	questions	in	this	forum	category.	If	you	don't	know	where	to	post,	please	read	the	different	forums'	rules.
Thanks.	vlcmo	Blank	Cone	Posts:	30	Joined:	28	Apr	2021	23:29	Postby	vlcmo	30	Jun	2024	04:42	Is	it	just	me,	or	did	VLC	lose	the	ability	to	play	YouTube	videos,	regardless	of	whether	it's	updated	to	the	latest	version?	vlcmo	Blank	Cone	Posts:	30	Joined:	28	Apr	2021	23:29	Postby	vlcmo	03	Jul	2024	01:20	Thanks.Don't	see	any	solutions	there.Is	there
anyone	whose	VLC	is	currently	able	to	play	YouTube	videos?	Lotesdelere	Cone	Master	Posts:	10363	Joined:	08	Sep	2006	04:39	Location:	Europe	Postby	Lotesdelere	03	Jul	2024	13:45	Don't	see	any	solutions	there.	Because	you	haven't	read	careful	enough.The	solution	is	to	update	the	LUA	script	when	a	new	version	will	be	available.	vlcmo	Blank	Cone
Posts:	30	Joined:	28	Apr	2021	23:29	Postby	vlcmo	03	Jul	2024	17:20	The	solution	is	to	update	the	LUA	script	when	a	new	version	will	be	available.Right,	and	currently	no	fixed	version	is	available.	Hence	my	question	if	every	VLC	user	has	this	issue.	Gruko	Cone	that	earned	his	stripes	Posts:	105	Joined:	28	Nov	2010	18:52	Postby	Gruko	04	Jul	2024
12:33	Yes,	of	course.	vlcmo	Blank	Cone	Posts:	30	Joined:	28	Apr	2021	23:29	Postby	vlcmo	05	Jul	2024	23:59	Is	this	the	longest	stretch	of	time	that	VLC	has	not	update	their	LUA	after	YouTube	streaming	stopped	working?	Rmi	Denis-Courmont	Developer	Posts:	15411	Joined:	07	Jun	2004	16:01	VLC	version:	master	Operating	System:	Linux	Contact:
Contact	Rmi	Denis-Courmont	Postby	Rmi	Denis-Courmont	06	Jul	2024	14:11	I	don't	think	so,	but	I	am	pretty	sure	that	nobody	kept	track	of	that	going	all	the	way	back	to	GoogleVideo.	Rmi	Denis-Courmont	messages	soliciting	support	will	be	systematically	discarded	vlcmo	Blank	Cone	Posts:	30	Joined:	28	Apr	2021	23:29	Postby	vlcmo	12	Jul	2024
23:29	So	will	VLC	update	itself	to	correct	this,	or	is	this	the	end	of	YouTube	streaming	on	VLC?	Lotesdelere	Cone	Master	Posts:	10363	Joined:	08	Sep	2006	04:39	Location:	Europe	Postby	Lotesdelere	16	Jul	2024	12:29	Yes,	it's	the	direct	download	link	but	it	doesn't	show	in	any	way	the	date	of	the	latest	update.	vlcmo	Blank	Cone	Posts:	30	Joined:	28
Apr	2021	23:29	Postby	vlcmo	16	Jul	2024	16:33	And	it	still	doesn't	work.	vlcmo	Blank	Cone	Posts:	30	Joined:	28	Apr	2021	23:29	Postby	vlcmo	19	Jul	2024	21:26	So	that's	almost	a	year.	Has	VLC	ever	not	updated	the	LUA	for	a	year	before?	WNG555	New	Cone	Posts:	1	Joined:	30	Aug	2022	10:40	Postby	WNG555	20	Jul	2024	00:12	Just	to	keep	this
thread	on	top,	I	too	can't	access	and	download	from	youtube	beginning	about	2	months	ago.	It	was	very	clunky	but	the	currently	dated	4/2023	youtube.lua	managed	to	connect	and	record	but	in	real	time.	Worked	up	to	Spring.	Now	it's	completely	dead.	Request:	I	hope	the	keepers	of	the	github	repository	or	author	of	youtube.lua	can	update	it.	It's
beyond	my	capabilities.	Thanks	in	advance.	vlcmo	Blank	Cone	Posts:	30	Joined:	28	Apr	2021	23:29	Postby	vlcmo	21	Jul	2024	03:44	So	does	ANYONE	have	any	idea	what's	going	on?	Rmi	Denis-Courmont	Developer	Posts:	15411	Joined:	07	Jun	2004	16:01	VLC	version:	master	Operating	System:	Linux	Contact:	Contact	Rmi	Denis-Courmont	Postby	Rmi
Denis-Courmont	21	Jul	2024	09:05	YouTube	updated	their	site	and	nobody	has	provided	a	patch	to	refresh	the	VLC	Lua	script.	That's	what's	going	on.That's	probably	not	what	you	want	to	hear	but	I'm	not	sure	what	answer	you	expect,	TBH.	Rmi	Denis-Courmont	messages	soliciting	support	will	be	systematically	discarded	vlcmo	Blank	Cone	Posts:	30
Joined:	28	Apr	2021	23:29	Postby	vlcmo	21	Jul	2024	20:54	Are	there	any	other	safe	media	players	that	are	currently	still	able	to	stream	YouTube	videos?	Return	to	VLC	media	player	for	Windows	Troubleshooting	Jump	to	Users	browsing	this	forum:	No	registered	users	and	99	guests	44918	Topics	187035	Posts	Last	post	How	to	open	Player	instances
by	oggmeista	View	the	latest	post	28	Jun	2025	19:23	11294	Topics	39607	Posts	Last	post	Re:	Prevent	window	opening	wh	by	tautin	View	the	latest	post	24	Jun	2025	12:37	10645	Topics	39385	Posts	Last	post	VLC	does	not	automatically	sh	by	schembs	View	the	latest	post	28	Jun	2025	04:29	2815	Topics	11277	Posts	Last	post	Re:	VLC	3.5	for	iPhone,
iPad	by	taylorfusion	View	the	latest	post	24	Jun	2025	21:57	5648	Topics	22179	Posts	Last	post	Re:	Invisible	player	by	Spike1	View	the	latest	post	28	Jun	2025	11:51	VLC	for	Windows	Store	VLC	for	Windows	Store	specific	questionsThis	includes	WinRT,	Windows	RT,	Windows	Phone,	Windows	Mobile	and	Xbox	1	319	Topics	1194	Posts	Last	post	Re:	No
VLC	in	french	store?	by	Lotesdelere	View	the	latest	post	09	Jun	2025	12:38	20714	Topics	68842	Posts	Last	post	Re:	Where	is	the	log	file	and	by	Lotesdelere	View	the	latest	post	16	Jun	2025	13:12	162	Topics	762	Posts	Last	post	Re:	Vietnamese	Translation	Re	by	fkuehne	View	the	latest	post	08	Feb	2025	19:00	VLC	media	player	Feature	Requests
Feature	requests	for	VLC.	7424	Topics	29057	Posts	Last	post	Re:	Keystrokes	for	Zoom	and	S	by	Rmi	Denis-Courmont	View	the	latest	post	28	Jun	2025	10:21	Jump	to	Users	browsing	this	forum:	No	registered	users	and	73	guests	Microsoft	Windows	specific	usage	questions	Forum	rules	Please	post	only	Windows	specific	questions	in	this	forum
category.	If	you	don't	know	where	to	post,	please	read	the	different	forums'	rules.	Thanks.	MariaClaudia	Blank	Cone	Posts:	19	Joined:	20	Oct	2023	16:26	VLC	version:	3.0.20	Vetinari	Operating	System:	Windows	Postby	MariaClaudia	01	Aug	2024	14:11	Good	morning.	Well	that.	It	seems	like	if	I	let	time	pass,	weeks,	when	I	resume	playing	a	file,	it
starts	from	the	beginning.	I	have	reinstalled	the	program	but	it	is	still	the	same.	Now	I	manage,	when	I	remember,	to	enter	in	the	comments	of	the	file's	metadata,	a	reference	to	the	location	where	I	am	leaving	it.	It's	frustrating.	Any	suggestions?	Lotesdelere	Cone	Master	Posts:	10363	Joined:	08	Sep	2006	04:39	Location:	Europe	Postby	Lotesdelere	02
Aug	2024	12:34	Tools	->	Preferences	->	Interface	->	Save	Recently	Played	Items	must	be	enabled.	MariaClaudia	Blank	Cone	Posts:	19	Joined:	20	Oct	2023	16:26	VLC	version:	3.0.20	Vetinari	Operating	System:	Windows	Postby	MariaClaudia	02	Aug	2024	16:04	Thank	you	very	much	for	answering.	Continue	playback?	-	>	AlwaysSave	recently	played
items	is	enabled.However,	as	I	said,	it	doesn't	always	save	the	position.	Something	I	forgot	to	mention	is	that	I	usually	access	mp4s	from	playlists.	Punktuation	New	Cone	Posts:	1	Joined:	11	Aug	2024	09:47	Postby	Punktuation	11	Aug	2024	09:50	Thank	you	very	much	for	answering.	Continue	playback?	-	>	AlwaysSave	recently	played	items	is
enabled.However,	as	I	said,	it	doesn't	always	save	the	position.	Something	I	forgot	to	mention	is	that	I	usually	access	mp4s	from	playlists.	This	has	been	happening	for	months	to	me,	too.	And	I	don't	access	files	from	playlists.It	happens	only	a	few	times	that	VLC	resumes	playback	from	where	I	stopped.	On	top	of	this,	I	uninstalled	VLC,	rebooted,
cleaned	the	registry	with	CCleaner,	rebooted,	reinstalled	VLC,	set	the	right	preferences	but	the	problem	still	persists.I	also	noticed	that,	if	I	try	to	set	bookmarks	as	a	workaround	to	this	problem,	they	are	not	saved.	aracuan	New	Cone	Posts:	1	Joined:	26	Oct	2024	15:35	Postby	aracuan	26	Oct	2024	15:39	Yeah	I	just	stopped	using	VLC	entirely	because
of	this.	Way	too	annoying	to	deal	with	constantly.I'll	just	find	a	player	that's	figured	out	the	one	feature	I	need	to	work	reliably.	Return	to	VLC	media	player	for	Windows	Troubleshooting	Jump	to	Users	browsing	this	forum:	No	registered	users	and	100	guests	Download	Switches	/S	-	Perform	silent	install/L=	-	Install	specified	language	as	default,	for
example	Czech	localization	means	/L=1029	Example	Useful	tips1)	Find	Locale	ID	for	your	language	here	VLC	uses	a	Nullsoft	installer,	so	the	correct	flag	is	/S,	and	not	/s.	The	flag	is	case-sensitive,	unlike	other	installers.Do	not	rename	the	setup	file	to	"vlc.exe".	The	installer	will	perform	a	check	to	see	if	any	VLC	processes	are	running,	and	gets
confused	by	seeing	itself	running	under	the	wrong	filename.	If	you	are	using	the	MSI	version,	the	arguments	are	"/qn"	Note	that	as	of	this	writing,	the	latest	version	does	not	have	an	msi	installer	-	I	had	to	grab	version	3.0.20.Russ	Microsoft	Windows	specific	usage	questions	Forum	rules	Please	post	only	Windows	specific	questions	in	this	forum
category.	If	you	don't	know	where	to	post,	please	read	the	different	forums'	rules.	Thanks.	Ghillie	New	Cone	Posts:	3	Joined:	07	Oct	2019	19:10	Postby	Ghillie	07	Oct	2019	19:22	Hey	all.	I've	just	bought	a	new	PC	and	I'm	having	some	issues	with	VLC	playback.	Just	about	anything	I	try	to	play	flickers	my	entire	screen	black.	The	video	comes	back	for
sometimes	20	seconds	sometimes	2	seconds	and	flickers	black	again.	I	never	had	this	issue	previously	and	I'm	not	quite	sure	why	I'm	having	it	now.	I	have	the	latest	drivers	and	the	latest	version	of	VLC.	RTX	2070	and	an	I7	9700KF	I	can	get	the	video	to	play	fine	on	Windows	GDI	Video	Output	but	everything	else	makes	the	screen	flicker.	I	should	add
this	only	happens	when	the	video	is	in	fullscreen.	Watching	with	the	window	maximised	the	video	plays	just	fine.	I'm	not	sure	if	this	is	a	hardware	issue	or	VLC	issue	but	any	help	solving	this	would	be	much	appreciated.	main	debug:	VoutDisplayEvent	'mouse	button'	0	t=8main	debug:	VoutDisplayEvent	'mouse	button'	0	t=9main	debug:
VoutDisplayEvent	'double	click'qt	debug:	Qt:	Fullscreen	state	changedqt	debug:	Qt:	Entering	Fullscreenmain	debug:	VoutDisplayEvent	'fullscreen'	1main	debug:	resized	to	2560x1440main	debug:	VoutDisplayEvent	'resize'	2560x1440main	debug:	VoutDisplayEvent	'resize'	2560x1440direct3d11	debug:	Detected	size	change	2560x1440main	debug:
auto	hiding	mouse	cursormain	debug:	auto	hiding	mouse	cursormain	debug:	VoutDisplayEvent	'mouse	button'	0	t=8main	debug:	VoutDisplayEvent	'mouse	button'	0	t=9main	debug:	VoutDisplayEvent	'double	click'qt	debug:	Qt:	Fullscreen	state	changedqt	debug:	Qt:	Quitting	Fullscreenmain	debug:	VoutDisplayEvent	'fullscreen'	0main	debug:	resized	to
2560x1419main	debug:	VoutDisplayEvent	'resize'	2560x1419main	debug:	resized	to	2560x1385main	debug:	VoutDisplayEvent	'resize'	2560x1385main	debug:	resized	to	2560x1367main	debug:	VoutDisplayEvent	'resize'	2560x1367main	debug:	resized	to	2544x1328main	debug:	VoutDisplayEvent	'resize'	2544x1328main	debug:	VoutDisplayEvent
'resize'	2544x1328direct3d11	debug:	Detected	size	change	2360x1328main	debug:	resized	to	2560x1314main	debug:	VoutDisplayEvent	'resize'	2560x1314main	debug:	VoutDisplayEvent	'resize'	2560x1314direct3d11	debug:	Detected	size	change	2336x1314main	debug:	auto	hiding	mouse	cursormain	debug:	auto	hiding	mouse	cursormain	debug:
VoutDisplayEvent	'mouse	button'	0	t=8main	debug:	VoutDisplayEvent	'mouse	button'	0	t=9main	debug:	VoutDisplayEvent	'mouse	button'	0	t=8main	debug:	VoutDisplayEvent	'mouse	button'	0	t=9main	debug:	VoutDisplayEvent	'double	click'qt	debug:	Qt:	Fullscreen	state	changedmain	debug:	VoutDisplayEvent	'fullscreen'	1qt	debug:	Qt:	Entering
Fullscreenmain	debug:	resized	to	2560x1440main	debug:	VoutDisplayEvent	'resize'	2560x1440main	debug:	VoutDisplayEvent	'resize'	2560x1440direct3d11	debug:	Detected	size	change	2560x1440main	debug:	auto	hiding	mouse	cursormain	debug:	discarded	audio	buffermmdevice	debug:	state	changed:	0wasapi	debug:	resetmkv	debug:	seek	request
to	36.85%main	debug:	Received	first	picturemain	error:	Timestamp	conversion	failed	for	100310001:	no	reference	clockmain	error:	Could	not	convert	timestamp	0	for	FFmpegmkv	debug:	seek:	preroll{	track:	1,	pts:	1349350000,	fpos:	446428770	skip:	446428770}	mkv	debug:	seek:	preroll{	track:	2,	pts:	1350101000,	fpos:	446646754	skip:
446646754}	mkv	debug:	seek:	preroll{	req:	1350172556,	start-pts:	1349350001,	start-fpos:	446428770}	main	debug:	Buffering	0%main	debug:	Buffering	1%main	debug:	Buffering	2%main	debug:	Buffering	3%main	debug:	Buffering	4%main	debug:	Buffering	5%main	debug:	Buffering	6%main	debug:	Buffering	7%avcodec	debug:	available	hardware
decoder	output	format	119	(cuda)avcodec	debug:	available	hardware	decoder	output	format	53	(dxva2_vld)avcodec	debug:	available	hardware	decoder	output	format	118	(d3d11va_vld)main	debug:	Buffering	8%avcodec	debug:	available	hardware	decoder	output	format	174	(d3d11)avcodec	debug:	available	software	decoder	output	format	0
(yuv420p)main	debug:	Buffering	9%avcodec	debug:	reusing	decoder	output	format	0main	debug:	Stream	buffering	done	(5838	ms	in	19	ms)main	debug:	end	of	video	prerollmain	debug:	Decoder	wait	done	in	9	msmmdevice	debug:	state	changed:	1main	debug:	auto	hiding	mouse	cursormain	debug:	auto	hiding	mouse	cursormain	debug:
VoutDisplayEvent	'mouse	button'	0	t=8main	debug:	VoutDisplayEvent	'mouse	button'	0	t=9main	debug:	VoutDisplayEvent	'double	click'qt	debug:	Qt:	Fullscreen	state	changedqt	debug:	Qt:	Quitting	Fullscreenmain	debug:	VoutDisplayEvent	'fullscreen'	0main	debug:	resized	to	2560x1419main	debug:	VoutDisplayEvent	'resize'	2560x1419main	debug:
resized	to	2560x1385main	debug:	VoutDisplayEvent	'resize'	2560x1385main	debug:	resized	to	2560x1367main	debug:	VoutDisplayEvent	'resize'	2560x1367main	debug:	resized	to	2544x1328main	debug:	VoutDisplayEvent	'resize'	2544x1328main	debug:	resized	to	2560x1314main	debug:	VoutDisplayEvent	'resize'	2560x1314main	debug:
VoutDisplayEvent	'resize'	2560x1314direct3d11	debug:	Detected	size	change	2336x1314	Ghillie	New	Cone	Posts:	3	Joined:	07	Oct	2019	19:10	Postby	Ghillie	07	Oct	2019	19:23	Had	to	remove	some	of	the	useless	debug	info	to	make	the	post	work.	but	thats	all	i	get	in	my	log	which	makes	me	feel	like	it	might	be	a	hardware	issue.	That	i	have	no	idea
how	to	fix	Teigh	New	Cone	Posts:	2	Joined:	12	Oct	2019	22:08	Postby	Teigh	12	Oct	2019	22:17	Hey	all.My	pc	uses	Windows	10	and	my	vlc	player	literally	doesn't	have	a	menu.	I	searched	for	ways	that'll	help	me	get	the	menu	to	appear	but	found	hence	I	ended	up	here.	And	I	also	need	help	with	videos	that	don't	play.	I	tried	watching	a	series	episode;
the	video	ends	up	freezing	on	the	same	scene	but	the	sound	continues	playing	without	hassles.	The	video	is	an	mkv	file.	What	can	I	do?	Teigh	New	Cone	Posts:	2	Joined:	12	Oct	2019	22:08	Postby	Teigh	12	Oct	2019	22:20	I	don't	know	which	vlc	version	I'm	using	but	when	I	right-click,	the	only	thing	that	appears	is	"play/pause,	stop,	audio,	video	and
playback"	only.	The	settings	tab	is	also	not	so	helpful.	Return	to	VLC	media	player	for	Windows	Troubleshooting	Jump	to	Users	browsing	this	forum:	No	registered	users	and	100	guests	
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